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About This Guide 
 

This NX Getting Started Guide provides an introduction to the NX Editor and NX Tester along with a 
programming example.  

Detailed information describing every aspect of the NX Editor is available in the NX Editor User’s Guide.  
The information in that guide is focused on the NX Editor and is intended to provide the reader with a 
comprehensive understanding of how to use the NX Editor.  

In addition to the guides, an extensive Knowledge Base is installed with the NX Editor.  The Knowledge 
Base is accessible from the NX Editor’s Help menu.   

 
The Knowledge Base includes Testers User`s Guides, that provides detailed information about the NX 
Tester’s menus and operations, Getting Started Guides to learn about the basic operations of the NX Editor 
and provides instructions for building a NX Editor program for the Demo Harness that is supplied as part 
of the Getting Started Kit for NX and NX Hipot Testers. 

Also, includes many Application Notes, each of which documents a how-to approach for programming the 
NX Tester to solve an application-specific problem.  Detailed background information as well as example 
programs are provided in each Application Note.  Topics covered include label printing, displaying a count 
of good harnesses, interfacing to external devices, reporting test results, Kelvin testing, Hipot testing, etc. 

After learning the basics of the NX Editor from the Getting Started Guide and from this Getting Started 
Guide, please examine the contents of the Knowledge Base to learn more about how to program the NX 
Editor to address many common wire harness testing scenarios. 

Copyright ©Dynalab Test Systems, Inc., 1988-2020.  All rights reserved. 
All features/functions mentioned within are subject to change. This document is for informational 

purposes only. Dynalab Test Systems, Inc., makes no warranties, expressed or implied, in this document.  
Dynalab® and NX® are registered trademarks of Dynalab Test Systems, Inc. 
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Thanks for choosing Dynalab Test Systems as your wire harness test equipment vendor.  As you are about 
to see, Dynalab’s NX System offers exceptional functionality and is easy to program and operate.   

The purpose of this Guide is to help you get started with the NX Editor software program and the NX 
Tester.  Detailed information is available in the User Guides, but we suggest that you follow the steps 
outlined in this Guide first to become quickly familiar with the basics. 

Before proceeding, make sure you have the following: 

• NX Tester 
• NX Editor Software – installed on a PC 
• Demo Harness and Fixture (supplied by Dynalab) 

 

This Guide provides an overview of the NX Tester followed by a step-by-step procedure for programming 
the Demo Harness.   The topics covered in this Guide are: 

 

 

ABOUT THIS GUIDE ...................................................................................................................1 

OVERVIEW OF THE DYNALAB NX TESTER.......................................................................4 

PROGRAMMING THE DEMO HARNESS ..............................................................................6 

STEP 1: DEFINE THE FIXTURE BLOCKS ..........................................................................................7 
STEP 2: DEFINE THE COMPONENTS .............................................................................................12 
STEP 3: DEFINE THE CONNECTIONS ............................................................................................14 
STEP 4: DEFINE THE WORK FLOW ...............................................................................................19 
STEP 5: AUDIT THE PROGRAM .....................................................................................................20 

CONNECT PC TO THE NX TESTER .....................................................................................21 

CONFIGURE THE NX EDITOR ..............................................................................................22 

DOWNLOAD THE NX EDITOR PROGRAM TO NX TESTER ..........................................23 

RUN THE PROGRAM ...............................................................................................................23 
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Overview of the Dynalab NX Tester 
 

The front panel of any NX Series Tester has the following features: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Speaker – The speaker is used to produce a variety of sounds. 
• Display – The 4 line x 20-character display provides useful information about the status of the test.  
• User Buttons – The arrow buttons are used to scroll through menus.  The green button is used to 

select menu items and to start programs.  The red button is used to stop program execution and to 
escape from menus. 

• Probe port – This accepts the Probe, a useful device for troubleshooting fixture wiring.  When 
probing a Test Point, the Tester will display the Test Point name.  

• NX Memory Card Slot – This slot accepts an NX Memory Card for the purpose of transferring 
programs from a PC to an NX Tester. 

• Key Slot – This slot accepts either a Supervisor Key or an Operator Key.   
The Supervisor Key unlocks access to Setup Menus, allows program termination, activates the 
control port, and allows advancing through errors.  The Supervisor Key may also be used to satisfy 
a test program’s requirement that a supervisor be present to continue.  The Supervisor Key contains 
data storage areas that can be programmed to contain the Supervisor’s ID and other useful data. 
The Operator Key may be used to satisfy a test program’s requirement that an operator be present to 
continue.  The Operator Key contains data storage areas that can be programmed to contain the 
Operator’s ID and other useful data. 

 
 

Probe Port 

Speaker Display 

User 
Buttons 

NX 
Memory 

Card Slot 

Key Slot 
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The rear panel of any NX Series Tester is designed to support the following features: 

 

 
 

• Serial Ports – Two serial ports are supplied as a standard feature on every NX Series Tester.  Serial 
ports are used to connect to a Remote Display, Label or Receipt Printer, or Bar Code Scanner.  Two 
additional serial ports and a network interface are available with the optional Communications Board, 
part number 5-4011. 

 
• Power Supply Receptacle – this accepts the DC connection from the Power Supply. 

 
• Control Port Interface – Connects to the Control Port Module.  The Control Port Module provides one 

set of contacts for output and one for input.  This provides a mechanism to control an external device 
such as a fixture clamp, or to receive input from an external device.  For more detailed information 
regarding the use of the Control Port Module, please refer to the NX Application Note entitled 
Interfacing to External Devices. 
 

• Extended Button Interface – In some cases, the test operator may not be able to easily reach the 
control buttons on the front panel of the NX Tester. To solve this problem, the NX Tester can be 
equipped with an Extended Button Pad - this provides the operator with complete control of the NX 
Tester from a distance.  The Extended Button Pad plugs into the Extended Button Interface. 
 

• USB Port – The USB port is available to connect to a PC.  A PC connection is used to support NX 
View software, to upgrade the NX Tester’s firmware, or to download test programs from the PC.  Note: 
the USB port is a standard feature in NX Testers manufactured in 2011 and later.  Older NX Testers are 
not equipped with a USB port.  
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Programming the Demo Harness 
A demo harness is supplied by Dynalab as a way of quickly learning how to program the NX Tester using 
the NX Editor.  The demo harness is provided with a demo fixture board. 

 

 

The demo harness consists of four connectors: A, B, C, and D.  
The harness includes a splice designated S1, a diode designated 
D1, and a resistor designated R1. 

 

 

 

 

 

 

 

 

The demo fixture board contains one 
fixture block for each harness connector.  
Additionally, the fixture blocks for 
connectors C and D each contain a 
detection switch, designed to detect a 
physical feature of the harness connector. 

For convenience, each fixture block has a 
visual aid graphic located next to it 
showing the pin numbers and the test point 
assignments. 

 

 

 

 

 

 

The demo fixture board also has a 64-pin connector at the top – this mates 
with a ribbon interface cable.  The other end of the ribbon interface cable 
plugs into the back of the NX Tester.
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To program the demo harness, start the NX Editor – the following is displayed: 

 
 

 

Step 1: Define the Fixture Blocks 
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Taking another look at the demo fixture board, there are 4 fixture blocks with the following characteristics: 

• Fixture Block A: 3 Pins 
• Fixture Block B: 4 Pins 
• Fixture Block C: 4 Pins and 1 Detection Switch 
• Fixture Block D: 3 Pins and 1 Detection Switch 

Enter information for each fixture block as follows: 
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First, make sure you are in the Fixture Blocks view.  The view is selected by pressing either of the blue 
arrows located on either side of the view selection window, or by pressing the down arrow in the view 
selection window and selecting Fixture Blocks. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Fixture Blocks view now shows Fixture Block A with 3 pins numbered 1, 2 and 3 and no Detection 
Switches. 
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To add a fixture block, press the green Add 
Item button as shown here. 

Enter the information for Fixture 
Block A as shown here, then press 
OK. 
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To add the next Fixture Block, press 
the Add Item button in the Fixture 
Blocks view. 

Enter the information for Fixture 
Block B as shown here, then press 
OK. 

To add the next Fixture Block, press 
the Add Item button in the Fixture 
Blocks view. 

Enter the information for Fixture 
Block C as shown here, then press 
OK. 

To add the next Fixture Block, press 
the Add Item button in the Fixture 
Blocks view. 

Enter the information for Fixture 
Block D as shown here, then press 
OK. 
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Once all Fixture Blocks have been added, the Fixture Blocks view should look like this: 

 
Note that in the center pane, there is an entry for every Fixture Block Pin and for every Detection Switch 
connection.  These are the connection points.  Each connection point must be wired to a Test Point on the 
NX Tester.  The Test Point assignments may be manually entered or may be generated by the NX Editor.  
In this example, the NX Editor will generate the assignments as follows: 

 
 

 

In the Assign Test Points window, make sure that the 
selections are made as shown here: 

For “Assign Test Points To:”, select All Rows 

For “Test Point Selection:”, select Automatic 

Press the OK button 

Press the Assign Testpoints button located in the left 
pane 



Dynalab Test Systems NX System Getting Started Guide  Page 11 
Copyright 2020    Revised 9/14/2020 
  

Once the test point assignments have been made, the Fixture Blocks View should look like this: 

 
 

 

 

 

At this point, it would be a good idea to save the program: 

 
  

Test Point assignments 

Select Save As from the File menu, and 
give the file an appropriate name such 
as Demo Harness. 
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Step 2: Define the Components 
The demo harness contains a splice, a diode, and a resistor.  These items are added in the Components 
view. 

 
 

 
 

 
Once Add Splice has been selected, the Components View looks like this: 

 
 

 

 
 

 
 

Note that a splice named S1 now appears 

To get to the Components view, select 
“Components” from the view selection 
menu as shown here. 

To add a Component, press the Add 
Item button in the Components View. 

To add the splice, select “Add Splice” 
from the Add Item menu. 

 

To add the diode, press the Add Item 
button in the Components View… 

and then select “Add Diode” from the 
Add Item menu 
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Once Add Diode has been selected, the Components View looks like this: 

 
 

 

 

 

 
 

 

 

 

 

Once Add Resistor has been selected, the Components View looks like this: 

 
Note that a resistor named R1 now appears.  The NX Editor automatically adds the resistor with a value of 
100 Ohms and a tolerance of 5%.  However, in the case of the demo harness, the value of the resistor is 
10,000 Ohms (10 k Ω), and the tolerance is 20%.  So, it will be necessary to alter the values shown in the 
Resistor Properties pane on the right side of the window to match the values of the resistor in the demo 
harness. 

 

 
 

 

Note that a diode named D1 now appears 

To add the resistor, press the Add Item 
button in the Components View… 

and then select “Add Resistor” from the 
Add Item menu. 

In the Resistor Properties pane, change the value to 
10.00 k Ω, and the tolerance to 20% as shown here. 
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Step 3: Define the Connections 
The harness wires (or connections) are added in the Connections View. 

 
 

Each wire constitutes a connection.  For each connection, enter the two connection points associated with 
the connection, the connection name, and the wire color as follows. 

 

To add connections, press the Add Item button in the Connections View. 

 
 

 

Enter the data for wire W1 as shown below, then press the Add button.  

 
 

 

Enter the data for wire W2 as shown below, then press the Add button. 
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To get to the Connections View, select 
“Connections” from the view selection menu as 
shown here. 
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Enter the data for wire W3 as shown here then press the Add button. 

 
 

Enter the data for wire W4 as shown here then press the Add button. 

 
 

Enter the data for wire W5 as shown here then press the Add button. 

 
 

Enter the data for wire W6 as shown here then press the Add button. 
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Enter the data for wire W7 as shown here then press the Add button.  Note that the “To” connection is the 
anode side of the diode : D1(a). 

 
 

 

Enter the data for wire W8 as shown here then press the Add button.  Note that the “From” connection is 
the cathode side of the diode : D1(c). 

 
 

 

 

Enter the data for wire W9 as shown here then press the Add button.  
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Enter the data for wire W10 as shown here then press the Add button.   

 
 

 

Enter the data for wire W11 as shown here then press the Add button.   

 
 

 

At this point, all harness connections have been entered.  In this case, the fixture contains two detection 
switches.  These must also be added to the Connections view.  Press the Add All Switches button to add 
the detection switches: 
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Now that all connections are defined, press the Close button in the “Add New Connection” window. 

 
 

The Connections View should now look like this: 

 
 

 

 

 

 

 

This completes the definition of connections.  This is a good time to save the file before proceeding: 

 

Wire Harness 
Connections 

Detection Switch 
Connections 

Note that all the connections defined are associated with the Main Phase – this can be seen in the 
Phase Properties pane on the left.   A test phase is a set of connections that are tested together.    
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Step 4: Define the Work Flow 
All the steps completed up to this point involved describing the harness and fixture, i.e. what is tested.  In 
this section, the Work Flow is defined, i.e. how to test.  This is defined in the Work Flow view.  

To get to the WorkFlow view, select “WorkFlow” from the view selection menu as shown here. 

 
 

The following initial WorkFlow view is displayed: 

 
This is the default Work Flow.  It is automatically provided by the NX Editor via the use of the default 
template that was installed with the software. 

The WorkFlow does the following: 

• Tests the harness and displays the errors (Test-Display) 
• Provides an audible Twirl sound and displays a message indicating that the harness successfully 

passed (U.I) 
• Tests for removal of the harness (Remove) 
• Jumps back to Start to repeat the process 

This default Work Flow is suitable for testing most wire harnesses. 
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Step 5: Audit the Program 
Note that the bottom right hand corner of the NX Editor displays an audit status.  At this point it displays 
the following: 

 
No Audit Status means that the program has not been audited for errors or warnings.  To execute an Audit, 
select Audit Program from the File pull-down menu: 

 
The NX Editor will respond with the Audit results.  For this exercise, there should be no errors and the 
Audit Results window should appear as shown below: 

 
Press Close to close the Program Audit Results window. The NX Editor test program is now complete. 
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Connect PC to the NX Tester 
The Demo Harness program must be downloaded to the NX Tester.   

If the NX Tester is equipped with a USB port, connect one end of a USB cable to a master USB port on 
the PC and the other end to the USB port on the NX Tester.  The correct USB driver is installed during the 
NX Editor installation. This USB driver will be loaded the first time the NX Tester is connected to the PC 
– this might take a minute or two.  (Note: the USB port is a standard feature in NX Testers manufactured 
in 2011 and later.  Older NX Testers are not equipped with a USB port. ) 

 

 

 
 

If the NX Tester is not equipped with a USB port, use the serial download cable provided by Dynalab, 
connect serial port 1 on the back of the tester to one of the computer’s serial ports.  Note that Serial Port 1 
can be used for downloading programs even if the tester is equipped with a USB port. 

 

 

 
 

Also, connect the Demo Fixture board to the Tester as shown. 
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Connect to master USB port on PC 
using USB cable 

Connect to COM port on PC using 
Dynalab serial download cable 
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Configure the NX Editor 
 

From the Tools menu in the NX Editor, select 
Editor Options. 

 

 

 

 

Select the computer serial port that is connected to the Tester in the Editor Options Form: 
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Download NX Editor Program to NX Tester 
Make sure the NX Tester is connected to the computer as described in the previous section, powered on, 
and at the main menu. 

Initiate the file transfer in the NX Editor by one of the following methods: 

 

Press the Transfer button on the toolbar 

 

OR 

 

Select “Transfer to Tester” from the File menu. 

 

 

 

 

 

Note: Instead of downloading the program from the PC to the NX Tester via the download cable as 
described above, it is possible to transfer the program using the NX Memory Card and the Reader/Writer.  
Refer to the NX Application Note entitled Transferring Programs with a Memory Card for details. 

Run the Program 
On the NX Tester, the display should look like this after downloading the program: 

 

 

 

 

Use the arrow keys to make sure that the cursor is pointing to RUN.  Then press the Green button to start 
the demo program.  Then begin assembling the demo harness to the fixture as instructed by the NX Tester. 

 

Congratulations 
You have just completed your first NX Editor program.  Experiment and try different things.  Refer to the 
NX Editor User’s Guide for more information about programming the NX Editor and the NX Tester 
User’s Guide for more information about the NX Tester. 

If you need technical assistance, feel free to contact us at Dynalab: 

Telephone: 614-729-6550 

Email: support@dynalab-inc.com 

Demo Harness 
>RUN        FILES 
 SELECT     SETUP 
 PROBE 

mailto:support@dynalab-inc.com

	About This Guide
	Overview of the Dynalab NX Tester
	Programming the Demo Harness
	Step 1: Define the Fixture Blocks
	Step 2: Define the Components
	Step 3: Define the Connections
	Step 4: Define the Work Flow
	Step 5: Audit the Program

	Connect PC to the NX Tester
	Configure the NX Editor
	Download NX Editor Program to NX Tester
	Run the Program

